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Zusammenfassung

Ausgehend von dem Hard- und Software-Entwurf der Schritt-fiir-Schritt- Anleitung fiir
den Entwurf und Test eines Minimalsystems wird eine weiteres »Software Application
Project« mit einem umfangreicheren Testprogramm angelegt und fiir den Test auch der
Debugger genutzt.

1 Anlegen eines weiteren » Application Projects«

SDK ist zu starten und der » Workspace« des Projekts zuvor auszuwiihlen (Abb. 1).

‘T Workspace Launcher x|

SP_AXI_BASH

Workspace: | [pRNjni(er=we g )
[~ Use this as the default and do not ask again

0K I Cancel |

Abbildung 1: Festlegung des Pfads fiir das Software-Projekt

Das Projekt hat bereits seine » Hardware Platform« und sein » Board Support Package«, so
dass sofort mit der Einrichtung eines neuen » Application Project« begonnen werden kann:

File > New > Application Project

Genau wie beim ersten » Application Project« sind die » Hardware Platform« und das »Bord
Support Package« zuzuordnen (Abb. 2). Nach »Next« soll bei diesem und auch allen kiinfti-
gen eigenen Software-Anwendungen »Empty Application« als Vorlage ausgewéhlt werden. Bei
»Empty Application« werden keine Programmdateien erzeugt. Die benotigeten C- und Header-
Dateien sind anschlieftend jeweils mit

File > New > Source File
bzw.
File > New > Header File

zu erzeugen und einzubinden. In dem sich darauthin 6ffnenden Fenstern ist jeweils der Datei-
Name einzutragen. Wichtig ist die Endung ».c« bzw. ».h«. Im Beispiel soll ein »Source File«
mit dem Namen »test io.c« erzeugt werden. Mit dem Source-File wird automatisch ein Ordner
»Debug« mit dem Linker-Skript, in das beim Ubersetzen auch das ausfiihrbare Programm
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4" New Project

=3l x|

Project name: | TestSerIn
[¥ Use default location

~ Target Hardware

Hardware Platform IBSP_A}G_Base_hw_platform

Processor I microblaze 0

[
[

~ Target Software

05 Platform Istandabne

Language ® C( C++

[

Board Support Package ( Create New |TestSer]n_bsp

& Use existing |standak)ne_b5p_[l

[

@ <Back | mext> |[ Fnsh ]

Cancel |

Abbildung 2: Einrichten des neuen Software-Projekts

geschrieben wird, angelegt (Abb. 3 links). In die Quelldatei soll das Programm in Abb. 3 mitte
eingegeben und gespeichert werden.

[ Project E &2

HE|¥ Y

= B8 0 s

B[ @) n.ﬂ »

= 0

» * test io.d]

&S HallowWelt

B2 Testlo
---@] Includes

é---[& Debug

 E@sIC

B sre
- [ test_io.c
-Ta] script.id

=-{ 8 BSP_AXI_Base_hw_|

--@ standalone_bsp_0

#include <xparameters.h>
#include <stdio.h>
#include <xio.h>

= int main(){
ug c, Ct;
while (1){
¢ = getchar();
putchar(c+l);

}

return @;

h

XIo Out8(XPAR_LEDS BASEADDR, Ct++);

e

Ol R oW

IJ
IJ

xparameters.h
stdio.h

xio.h

main() : int

~[E] README.txt |([=/ problems (J‘:. Tasks (E Console =~ E Properljes} el Term'maﬂ

CDT Build Console [TestIO]

T E N RE R N =R

overflowed by 8808 bytes
make: *** [TestI0.elf] Fehler 1

../microblaze-xilinx-elf/bin/1d.exe:
region “microblaze @ i bram ctrl microblaze ® d bram ctrl®

Abbildung 3: Explorer-Ansicht des neuen Software-Projekts und eingegebenes Programm

Das Programm liest in einer Endlosschleife mit der Funktion »getchar()« aus »stdio.h« ein
Zeichen von der Standardeingabe, sendet es um eins erhoht zuriick, zdhlt die empfangenen
Zeichen in einer Bytevariablen und gibt den Z&hlwert auf die Leuchtdioden aus. Die Fehlermel-
dung beim Ubersetzen in Abb. 3 »... overflowed by 8808 bytes« besagt, dass das Programm fiir
den verfiigbaren Befehlsspeicher zu grof ist. Ubersetzbar wird das Programm erst, wenn sowohl
die Programmzeile mit der Funktion »getchar()« als auch die mit der Funktion »putchar()«
auskommentiert wird. Die iiber die »stdio.h« eingebundenen Standardeingabefunktionen sind
offenbar entweder zu grof fiir den verfiigharen Programmspeicher oder fehlerhaft.
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2 Geeignete Ein- und Ausgabefunktionen

Das »Board Support Package« stellt eine Vielzahl weiterer Ein- und Ausgabefunktionen fiir die
vorhandenen Hardware-Einheiten zur Verfiigung. Uber den Header »xuartlite 1.h« lassen sich
beispielweise folgende Funktion fiir das Senden und den Empfang von Bytes einbinden:

XUartLite_SendByte(<Adresse_Senderegister>, <Bytewert>);
<Bytewert> = XUartLite_RecvByte(<Adresse_Empfangsregister>);

Abb. 4 zeigt ein vergleichbares noch etwas erweitertes Programm mit diesen Ein- und Ausgabe-
funktionen, das iibersetz-, link- und ausfiihrbar ist. Die While-Schleife vor der Endlosschliefe
gibt die Zeichenkette »Start Testschleife:« aus, um zu signalisieren, dass das Programm l3auft.

#include <xparameters.h>
#include <xio.h>
#include <xuartlite 1.h>

int main()}{
ug c, Ct;
char *str = "Starte Testschleife:\r\n";
while (*str != @) {
XUartLite SendByte(XPAR UARTLITE_@ BASEADDR, *str):
str++;

while (1){
¢ = XUartlLite RecvByte(XPAR UARTLITE @ BASEADDR);
XUartLite SendByte(XPAR UARTLITE @ BASEADDR, c+1);

,  XIo_Out8(XPAR_LEDS_BASEADDR, Ct++);

} return @;

Abbildung 4: Geédndertes Programm, in dem getchar() und putchar() durch funktionsgleiche
Funktionen aus anderen Bibliotheken ersetzt sind

Vor dem Programmstart ist, falls noch nicht erfolgt, wieder iiber das Meni
Xilinx Tools > Program FPGA
Die Hardware-Konfiguration in den FPGA zu laden. Danach ist mit mit

Run > Run Configurations.. >
Rechtsklick auf »Xilix C/C++ application (GDB)< > New

eine neu »Run Configuration« zu erstellen und auszuwéhlen ((Abb. 5)). Auch hier ist wieder
unter dem Reiter »STDIO Connection« der Haken bei » Connect STDIO to Console« zu setzen
und »JTAG UART« als Port auszuwéhlen. Der Programmstart erfolgt wieder mit » Run« bzw.
tiber die Schaltfliche .

Abb. 6 zeigt die Ein- und Ausgaben auf der Konsole. Die Ausgabezeichen sind schwarz und
die Eingaben griin dargestellt. Zuerst wird der Text »Starte Testschleife« ausgegeben. Dann
wurden zweimal mehrere Zeichen eingegeben. Die Ubergabe an das zu testende Rechnersystem
erfolgt erst bei » Enter«. Ausgegeben werden jeweils die Folgezeichen in der ASCII-Tabelle, d.h.
fiir eine »a« ein »b« und fiir ein »s« ein »t«. Auch das »Enter« Zeichen wird um eins erhdht.
Der Ausgabewert auf den Leds erh6ht sich bei jedem »Enter« um die Zeichenzahl. Allerdings
erfolgt die Ausgabe bitgespiegelt, d.h. auf Led(7) wird das niederwertigste und auf Led(0) das
héchstwertigste Zahlbit ausgegeben.
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Project:
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TestIO Debug [Xiinx C/C++ application (GDB)]

Starte Testschleife:

asd
bted123
234B3ex
[FybE

a

Abbildung 6: Testausgabe

3 Test mit dem Debuggers

[v Select configuration using 'C/C++ Application'

[«

Abbildung 5: Haupteintrige der neuen » Run Configuration«

Wenn, wie im Beispiel, die » Run Configuration« richtig eingestellt und ausgewahlt ist, wird der

Debugger mit

Run > Debug

oder einen Klick auf das Kéfersymbol % gestartet. Falls auf dem Prozessor ein Programm lauft,
ist die Frage »Would you like to terminate previous launch?« mit »Yes« zu beantworten. Die
Frage »switch perspective?« ist auch mit » Yes« zu beantworten. Richten Sie die Debug-Ansicht
so ein, dass, wie in Abb. 7 links der Quellcode mit Zeilennummern'!, rechts die Variablen und
ihre Werte und darunter die Console mit den Ein- und Ausgaben angezeigt werden.

8

char *str = "Starte Test
while (*str != @) {

str++;

h

schleife:\r\n";

XUartLite_SendByte(XPAR_UARTLITE_@_BASEADDR, *str);

dlldMES

Name Value
)= C 4
()= Ct 16
= = str 0x000007e8
(9= *str 'g

E Console i3

| Tasks| & Terminal| 5. Problems| () Executables| O Memory|

TestIO Debug [Xiinx C/C++ application (GDB)] ...\Debug\TestIO.elf (11.11.14 10:49) [Console connected to JTAG UART]

Abbildung 7: Debug-Ansicht nach dem ersten »Step Over«

'Rechtsklick auf den Rand vor einer Programmzeile und aktivieren von » Show Line Numbers«.
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Gehen Sie mit & (Step Over) wie im Bild mit dem blauen Abarbeitungszeiger bis vor die
while-Schleife in Zeile 14. Der Zeiger »str« zeigt auf den Anfang der Zeichenkette. Offnen Sie
wie in Abb. 8 ein Memory-Fenster, das den Speicherbereich ab Adresse »0x7TE8« anzeigt. Mit
einer ASCII-Tabelle ldsst sich iiberpriifen, dass die ab dieser Adresse gespeicherten Werte 0x53,
0x74, 0x61, 0x72, 0x74, ... genau den Ausgabetext darstellen.

| & Console fé Tasks r;.'ﬂ Terminal [ % Problems (@ Executables fD Memory 5 . Hg Progreﬁw Tt ||v_t=| (2] IEJ

Monitors % % % (0x000007e8 : 0x7E8 <Hex> £2 . < New Renderings... |

------ % 0x000007¢8 Address (@6 -3 [a-7 s8-8 c-fF |
0POPO7E® FFFFFFFF 00000000 74652054
PPOPO7FO 65737473 63686065 6966653A 0DOAGSOV

Abbildung 8: Speicherfenster mit dem Ausgabetext

Setzen vor Zeile 16 mit der Anweisung »str+-+« einen Unterbrechungspunkt, bei dem Sie
iiber das Menii in Abb. 9 einstellen, dass er erst beim fiinften Treffer das Programm anhalt und
starten Sie das Programm mit ® (Resume).

Class: C/C++ Line Breakpoint

Type: Reqular

File: H:\Softprozessor\SW_BSP_AXI_BASE\TestSerIn\main.c
Line number: | 16

[¥ Enabled

Condition: |

Ignore count: |5
Abbildung 9: Editierfenster fiir Unterbrechungspunkteinstellungen

Das Programm durchlauft fiinfmal die Schleife, erhht den Zeiger »str« um fiinf und gibt
die ersten fiinf Zeichen des Ausgabetextes, d.h. die Teilzeichenkette » Starte« aus (Abb. 10).

€ test_jo.c %2 Bl
int main(}{
ug c, Ct; ) Name |Va|ue
char *str = "Starte Testschleife:\r\n"; 00 C 1
while (*str != 0) { 9= Ct 17
XUartLite SendByte(XPAR_UARTLITE @ BASEADDR, *str); o % str Ox000007Fd
str++; *
2 =)= *sir
¥
(E Console I3 .+ Tasks] o Terminaﬂ o Problems} ¥ ] Executableﬂ i Memorﬂ

Starte

Abbildung 10: Debug-Ausgabe am Unterbrechungspunkt

Als néchstes soll der jetzige Unterbrechungspunkt geléscht und wie in Abb. 11 ein ein-
facher Unterbrechungspunkt hinter die Anweisung fiir den Byte-Empfang gesetzt werden. An-
schliefend ist das Programm mit I (Resume) fortzusetzen. Die Zeichenkette wird fertig aus-
gegeben (Abb. 12). Dann sollen Zeichen ’1’, '2’, ... eingegeben werden, die griin angezeigt
werden.

Das Programm erreicht nicht den Unterbrechungspunkt, hilt auch nicht an und zeigt auch
keine Variablen an, bevor auf der Console ein » Enter« eingegeben wird. Nach der Eingabe von
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while (1){
¢ = XUartlLite RecvByte(XPAR UARTLITE @ BASEADDR);
XUartLite SendByte(XPAR UARTLITE @ BASEADDR, c+1);
XIo Out8(XPAR LEDS BASEADDR, Ct++);

}

Abbildung 11: Setzen des zweiten Unterbrechungspunktes

El Console 2 v Tasks} o Term]naﬂ o ProbLems] o Executables} i} Memorﬂ
TestIO Debug [Xiinx C/C++ application (GDB)] ...\Debug\TestIO.eff (11.11.14 10:49) [Console connected to
Starte Testschleife:

1245

Abbildung 12: Testaus- und Eingabe vor der Eingabe von »Enter«

»Enter« schickt die Console alle vier Zeichen an das Programm. Das liest das erste Zeichen, in
der Abbildung eine '1’, ein und hilt am Unterbrechungspunkt an. Mit @ (Step Over) wird das
néchste Zeichen in der ASCII-Tabelle "2’ ausgegeben (Abb. 13). Noch einen Schritt weiter wird
der initiale, um eins erhéhte Zahlwert der Variablen »Ct«, hier 0x18, ausgegeben?.

[ main.c 32\ [ _start) | =5
9 while (1){
4 ¢ = XUartlLite_RecvByte(XPAR_UARTLITE_@ BASEADDR}; | Name |Va|ue
1 XUartlLite_SendByte(XPAR_UARTLITE_@ BASEADDR, c+1); = C 1!
2 XTo_Out8(XPAR_LEDS_BASEADDR, Ct++); )= Ct 17
3 1 » st 0x000007fe
4 return @;
5 1}

El console 3 . v Tasks] o Terminaﬂ [} Problems} ¥ ] Executableﬂ i Memorﬂ =3 Progreﬁw
Starte Testschleife:

&d_f
Abbildung 13: Ein- und Ausgabe nach »Step Over« vom zweiten Unterbrechungspunkts

Experimentieren Sie mit dem Programm weiter:

e Fortsetzen mit = (Step Over),

e Fortsetzen mit #= (Step Into),

e Setzen und Loschen von Unterbrechungspunkten,

e Fortsetzung mit = (Resume),

e Anhalten, wenn das Programm keinen Unterbrechungspunkt erreicht, mit ™0 (Suspend),
e Beenden der Programmabarbeitung mit ® (Terminate) und

e Neustart ab Programmbeginn mit % (Debug).

Die Arbeit mit einem Debugger erfordert Ubung. Noch mehr Ubung erfordert es, ein Programm
so zu schreiben, dass es sich mit verfiigharen Debug-Funktionen gut testen lésst.

2Wegen der fehlenden Anfangsinitialisierung der Variablen » Ct« ist das ein zufilliger Ausgabewert, der bei
jedem Programmstart anders sein kann. Damit ist der erste offensichtliche Fehler im Programm gefunden. Denn
das Programm soll sicher keine Zufallswerte auf die Leds ausgeben.



